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ABOUT THIS BOOK

Purpose

The Lucent Technologies INTUITY
TM Message Manager Release 4.5 Administration book

(585-310-809) contains installation and troubleshooting instructions for Message Manager
administrators.

Intended Audience

This book is intended for Message Manager administrators who are ready to install or
upgrade to Release 4.5. Readers should have a basic familiarity with Microsoft

WindowsTM ’95 or NT operating systems. Readers should also be familiar with AUDIX

messaging.

How This Book is Organized

This book is organized as follows:

■ Chapter 1, “Introduction”, summarizes Message Manager features, Release 4.5
enhancements, and related documentation.

■ Chapter 2, “Pre-Installation Requirements”, provides requirement, planning, and
upgrade information.

■ Chapter 3, “Installation”, provides instructions and screen explanations for each of the
Message Manager Release 4.5 installation processes.

■ Chapter 4, “Troubleshooting”, provides explanations, solutions, and steps for common
problems.

Conventions

This document uses the following conventions:

■ Text that you type or enter appears in bold type.

■ Screen names, field names, menu items, and keyboard keys have the first letter
capitalized. For example: select Print from the File menu, or press the Enter key.
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■ Screen buttons that you can select appear in bold type, such as the OK or Cancel
button.
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INTRODUCTION

Welcome to Lucent Technologies INTUITYTM Message Manager, a tool for handling your
multimedia messages through the convenience of a personal computer (PC).

Message Manager allows you to access your AUDIX® messaging system visually through
a local area network (LAN) connection. The AUDIX system is referred to as the "AUDIX
server" when it connects to a LAN.

Standard Features

This Windows-based application provides the following features:

■ Visual display of your AUDIX mailbox, with the ability to play voice messages, view
faxes and text messages, and launch or export file attachments, through a simple
graphic interface

■ A Personal Address Book for storing addresses and important information on your PC,
independent of the AUDIX server

■ Personal folders for sorting and storing messages on your PC, independent of the
AUDIX server

■ Soundcard support for playing and recording messages and greetings on your PC,
depending on availability of soundcard, speakers, and microphone.

■ Remote, off-site access to your messages through a high-speed modem and TCP/IP
(PPP) access to your LAN, depending on hardware availability

■ On INTUITY AUDIX Release 4 servers only, the ability to receive, create, and send text
messages and attached files

■ Fax messaging, depending on the release and configuration of your AUDIX server.
Users can receive, forward, delete, print, or create fax messages.

■ Internet Messaging, depending on the release and configuration of your AUDIX server.
Users can send and receive voice, fax, text, and attached file messages over the
Internet. For more information, search online help for Access the Internet.

Release 4.5 Enhancements

Message Manager Release 4.5 enhancements include:

■ 32-bit Architecture
Now that Message Manager is designed specifically for Windows ’95 and NT, you can:

1
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use the right mouse button to access mini-menus of common tasks, roll the cursor over
buttons and messages for immediate help, and use long file names (Windows ’95 and
NT 4.0 only) for attached files.

■ Enhanced Fax Features
With these great new fax features you can: send the same fax to many recipients but
address each cover page individually, forward selected pages of a multiple-page fax,
and customize the default cover page with your company’s name and logo.

■ Ease-of-Use Enhancements
Now you can: quickly change Message Manager settings on the Preferences form; print
text messages, faxes, and message headers with the Quick Print button; and change
personal folder names just by clicking on them.

■ Send Multiple Workbench Messages
If you’re working offline, you can create several messages, store them in your
Workbench folder, then send them all at once next time you log in.

Related Documentation

The following information is available:

■ To prepare your AUDIX system for Message Manager, refer to the DEFINITY AUDIX
R3.1 or R3.2 library or the INTUITY R2, R3, or R4 library for planning, installation,
administration, troubleshooting, or feature information.

■ You can provide a Quick Reference Card to your users. Three different formats of the
Message Manager R4.5 Quick Reference Card are provided in the document directory
of the Message Manager Release 4.5 CD:

 .doc format, which you can edit, display and print using Microsoft Word. If
necessary, you can download a free copy of Microsoft Word Viewer from
www.microsoft.com that will allow you to display and print the .doc file.

 .pdf format, which you can display and print using Adobe Acrobat Reader. You
can download a free copy of Acrobat Reader from www.adobe.com.

 .rtf format, which you can edit, display, and print using Microsoft Word or
Microsoft WordPad. WordPad is preinstalled on most Windows ’95 and NT
systems.

■ You can provide an electronic multimedia Overview that introduces your users to
Message Manager Release 4.5. The Introduction to Message Manager Overview is
provided in the IntroMM directory on the Message Manager CD.

■ When Message Manager users select About Your System... from the Help menu, they
are viewing the custom.txt file. As the system administrator, you can revise the
custom.txt file to include any information you think will be useful to your subscribers.
See Updating Your Site-Specific Information on page 19 for more information.
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PRE-INSTALLATION

CONSIDERATIONS

Introduction

This chapter describes Message Manager Release 4.5 installation prerequisites and the
installation choices for setting up and running Message Manager.

NetCare

The Lucent Technologies NetCare group provides varying degrees of consultative and
implementation assistance for your LAN, PC, and telecommunication administrators. As
a customer you may choose one of the NetCare offers that provide you with a consultant
at your business location. You may also choose to work with a consultant remotely (over
the phone).

For details, pricing, and scheduling of these offers, or for pre-sale support, please contact
your Lucent Technologies representative or NetCare at one of the following numbers:

■ United States, call 800-334-1096.

■ Europe/Middle East/Africa region, call 32-2-727-9853.

■ Asia Pacific region, call 91-80-331-6105.

■ Australia and New Zealand, call 61-2-9352-9022.

■ Caribbean/Latin America region, either call 305-569-4740, fax requests to 305-569-4753,
or for emergencies call 91-80-331-6105 or 6102.

PC Requirements

Verify you have the following minimum hardware and software:

■ One of the following compatible operating systems:

 Windows NT Version 3.51, with Service Pack 5

 Windows NT Version 4.0

 Windows 95

2



Pre-Installation Considerations

4 Issue 1  May 1998

■ Minimum of a 486, 66 MHz PC with 16 Mbytes of RAM and 19 Mbytes of available
hard disk storage (assuming a Personal Address Book with 400 entries). Exceptions:

 The tutorial requires an additional 10 Mbytes of disk storage.

 Your operating system may recommend additional RAM for better performance
(for example, 32 Mbytes of RAM for Windows NT).

■ VGA or higher monitor (color recommended)

■ LAN interface card

■ Windows Sockets (WINSOCK.DLL) access to TCP/IP (either through a NetWare
Loadable Module or TCP/IP protocol stack)

■ Recommended: Mouse supported by Microsoft Windows

■ Optional: Speakerphone, telephone headset, or a Microsoft Windows-compatible
soundcard with speakers, microphone, or a computer headset for hands-free operation

LAN and AUDIX Server
Requirements

Requirements for the local area network (LAN) include:

■ LAN configuration that provides TCP/IP transport between the AUDIX server and
client PC (Ethernet networks such as the Novell NetWare 3.11 operating system have
been tested)

■ Ethernet network segment with valid physical connection: 10BaseT twisted-pair for a
DEFINITY AUDIX server, and either 10BaseT, 10Base2 (thin coax), or 10Base5 (thick
coax) for an INTUITYTM AUDIX server.

 Message Manager can communicate with a token ring network if a customer-provided
router or other device converts token ring protocol to the required Ethernet protocol.

The following servers support Message Manager Release 4.0 or later software:

Server Type of media supported

INTUITY AUDIX Release 4.2-5 or
greater

Voice, fax, text, attached files, and Internet
Messaging

INTUITY AUDIX Release 4 or greater Voice, fax, text, and attached files

INTUITY AUDIX Release 3.3 Voice and fax messaging

INTUITY AUDIX Release 3.2 Voice messaging only

DEFINITY AUDIX R3.1 and R3.2 Voice messaging only
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Some Message Manager features may not work well with AUDIX servers prior to AUDIX
Release 3.3. For example:

 Outgoing folder entries may not display correctly on DEFINITY AUDIX or
INTUITY AUDIX Release 3.2 servers.

 Subject-only messages are not handled well through the telephone interface prior
to INTUITY AUDIX Release 4 servers. For example, an earlier AUDIX server may
announce a voice message of 0 length.

 AUDIX Release 4 servers deliver as much of a message to a remote server as they
can (for example, only the voice part if the recipient’s server supports only voice).
Earlier servers try to deliver the entire message; if they can’t, message delivery
fails.

Internet Messaging Requirements

Message Manager Release 4.5 supports Internet messaging if the following additional
requirements are met:

■ INTUITY AUDIX Release 4.2-5 or greater within the United States and Canada, or
Release 4.3 for all other countries

■ INTUITY Internet Messaging (IIM) software and site license

■ Two dedicated trusted servers

■ TCP/IP connection with a valid Internet service provider or a direct email gateway to
the Internet

■ NetCare Offer (highly recommended)

Installation Prerequisites

Before you install Message Manager, make sure your PC and LAN are ready to support
Message Manager as follows:

■ On your PC, log into the network and bring up Microsoft Windows.

■ Get a server name or TCP/IP address of a machine in your network from your LAN
administrator, then run the ping program from a DOS prompt in Windows ("ping" the
address or name). A ping from the DOS shell without Windows running is not a good
test. Ask your LAN administrator how to access or use this utility if you need help.

■ If the ping fails or the system hangs, install Message Manager and click on the Message
Manager Help icon in the Message Manager program group. Search for "General
Troubleshooting" for additional options.

■ If you install a shared copy of Message Manager for users to run on the LAN and copy
Message Manager software to a LAN server for easy distribution, the executable
Message Manager software and the copy of the software CD must be in different
directories.

■ For Windows NT, you must have administrative privileges or be logged in as
Administrator to successfully install the fax package.
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Operating System Considerations

The Message Manager Setup program automatically tailors Message Manager to work
with the operating system installed on your PC. Operating system considerations include:

■ Message Manager Release 4.5 runs as a 32-bit application on Windows 95 and
Windows NT (NT version 3.51 requires Service Pack 5).

■ Message Manager Release 4.5 cannot run on Windows 3.1, 3.11, or NT 3.51 that lacks
Service Pack 5. To run Message Manager on a 16-bit system, obtain Message Manager
Release 4.3.

■ If you change operating systems, you must reinstall Message Manager. Also, if your PC
is set up to run multiple operating systems (such as Windows NT and Windows 95),
Message Manager must be installed separately for each operating system.

Select Installation Type

Several methods of installation and operation are available for Message Manager Release
4.5. As you are completing the install process, you will need to designate what type of
installation you want for your site.

■ CD. You can install a copy of Message Manager on each PC using the CD that was
included in your installation package. The CD contains the following files:

 Message Manager Release 4.5 application

 Introduction to Message Manager electronic tutorial

 Electronic documentation in three formats (.doc, .rtf, and .pdf)

■ Copy from LAN Server. You can install a copy of Message Manager on your PC by
accessing the software through a LAN file server. This method allows administrators to
easily distribute Message Manager through a LAN instead of passing around the CD.
See Installing Message Manager from a LAN Server on page 15.

■ Run from LAN Server. All users on a LAN server share a single copy of Message
Manager. Because the Message Manager software exists only on the LAN file server, it
can be easily updated by the LAN administrator. See Installing and Accessing a Shared
Copy of Message Manager on page 13.

■ Automated Installation. You can start an automatic installation to load users’
computers with an entire set of application software, including Message Manager, as
defined by your company. This method allows administrators to easily distribute a
uniform set of user software to all computers. See Using the Automated Installation on
page 16.
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Advantages and disadvantages of installation and operation choices

Install Method Advantages Disadvantages

CD
■ Fast load for users with

slow LAN connection
(remote access).

■ Administrator cannot
password-protect the
CD.

■ Requires CD
distribution at each
update

LAN distribution
■ Fast load for users with

LAN connection.
■ Secure — directory can

be password-protected.
■ No CD to manage.
■ Users easily updated if

software changes.

■ Requires disk space on
LAN server

■ Increases network
traffic during
installation

Shared copy on LAN
■ Saves disk space on

user’s computers.
■ Secure — software can

be password-protected.
■ No diskettes to manage
■ Users easily updated if

software changes

■ Requires disk space on
LAN server

■ Can greatly increase
network traffic

■ May have much slower
execution speed,
depending on LAN
performance

Automated installation
■ Simplest install for

users
■ Administrator

resources required only
initially

■ Fast load for users with
slow LAN connection
(remote access)

■ System administrator
must custom-build,
load and distribute
installation media.

■ Requires software
media distribution at
each update

Upgrade Considerations

If you’re upgrading from an earlier release of Message Manager to Release 4.5, you’ll be
able to choose whether you want to replace your existing version of Message Manager or
keep two versions of Message Manager installed on the same PC.

Before Installation

■ Make a backup copy of the following directories and their contents:

 Workbench (Workbnch)

 Personal Folders (default names are PF1, PF2, PF3, PF4, and PF5)

 Address Book (PBOOK.MDB)
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During Installation

■ Close all Windows programs, including your current version of Message Manager.

■ To save a copy of your current Message Manager software, select a new directory name
and program group when you install Release 4.5

■ When you install the Message Manager "basic" software, it removes any Message
Manager fax print drivers from the computer. Also, although you can have two
releases of Message Manager on the computer, you can only have one set of fax print
drivers.

 After you install the basic software, install (or reinstall) the fax software that
corresponds with the Message Manager release you will use for faxing.

After Installation

■ The first time you open Message Manager Release 4.5, you’ll be asked to choose
whether to convert your existing workbench and personal folders to the new release.

 If you convert them, the messages in them can no longer be accessed by earlier
releases of Message Manager.

 If you do not convert your personal folders, you must set up new personal
folders in Release 4.5 under the main screen File menu. To later convert a
personal folder, select the folder as one of your Release 4.5 personal folders.

■ If you choose to keep a previous version of Message Manager, Release 4.5 uses the
Address Book, Personal folders, and Workbench files located in the directory that was
established with the previous version of Message Manager. To protect your files from
accidental deletion, use File Manager or Explorer to copy the following directories and
files into the directory where you install Release 4.5:

 PF1, PF2, PF3, PF4, and PF5 (and their contents). Then select Set Personal Folder
Properties from the File menu to set each new file location.

 Workbnch (and its contents). Then use Select Workbench Directory from the
File menu to set the new file location.

 PBOOK.MDB. To set the new location, open the Personal Address Book, select
Open from the File menu, browse to the new location, and select PBOOK.MDB.

■ The installation process provides several shortcut icons in the Message Manager
Windows program group and Start menu. The following icons are valid for Message
Manager Release 4.5:

 Fax Cover Page Wizard

 Help - US English

 Message Manager

 Personal Address Book

 ReadMe
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Uninstalling Message Manager

Previous versions of Message Manager stay on your system until you replace or remove
them. The way that you unistall Message Manager depends on which release of Message
Manager you wish to remove:

■ To remove Message Manager Release 4.3 or earlier, you can overwrite the files by
loading Message Manager 4.5 into the same directory, or you can delete the Message
Manager directory and files. See Upgrade Considerations on page 7 for more information
about file management during upgrades.

■ To remove Message Manager Release 4.5 or later, you can remove the application by
running unwise.exe from the Message Manager directory.
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INSTALLATION

Introduction

During the installation process, you will have to designate the following:

■ Which installation type to perform

■ Which parts of the application to install (basic and/or fax packages). For Windows NT,
you must be logged in as Administrator to successfully install the fax package.

■ Whether users will run Message Manager from their PCs or share a copy from the
LAN. See Select Installation Type on page 6 for more information.

■ Whether to back up files (in the case of upgrades and reinstalls)

Single User Installation Process

The default method of installation is from the CD to a single PC. The installation table in
this chapter assumes that you are installing to a single PC. Other install and operation
methods (install from a LAN, run shared copy from a LAN, and automated install) are
described in subsequent sections.

1 Run setup.exe.

2 Complete the steps listed in the following table to install Message Manager Release
4.5.

Screen Name Notes

Welcome
License File
Tell Me About… Included on your Message Manager CD are the

following information tools:
■ Install description
■ User Overview/Tutorial
■ Documentation

3
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Screen Name Notes

Select Installation Type The following installation choices are described in
Select Installation Type on page 6:

■ Single User Install (Continue with the instructions
in this table.)

■ Shared Installation (Go to Installing Message
Manager from a LAN Server on page 15.)

■ Copy for LAN Installation (Go to Installing and
Accessing a Shared Copy of Message Manager on page
13.)

■ Automated Installation is available, although it is
not a selection on the Installation Type screen. (Go
to Using the Automated Installation on page 13.)

Important! message You should close any open software applications. For
Windows NT, you must have administrative privileges
or be logged in as Administrator to successfully install
the fax package.

Select Destination Directory If you want to load the program in a directory other
than the default, browse to the directory of your
choice. If you want to create a new directory, type the
path for the new directory in the Select Destination
Directory dialog box.

Backup Replaced Files Backed up files are saved in the Backup directory.
Personal Folders, Workbench, and Address Book files
are not automatically backed up; see Upgrade
Considerations on page 7.

Select Components For a complete installation, select Message Manager
and FAX. To add fax to a previous installation, just
select FAX.

Enter FAX Information If you selected FAX on the Select Components screen,
you may enter the Server ID and Extension. The
information determines which AUDIX mailbox opens
when the user creates a fax. You can select
Options/Preferences in Message Manager to add or
update this information at a later time.

Ready to Install,
Installation Status Indicator

When you click Next on the Ready to Install screen,
you’ll see the Status Indicator and a listing of the
installed files.

hints.txt The hints.txt screen contains a description of each
program group icon.

Installation Complete,
Restart dialog box

The newly installed Message Manager will take effect
when you restart the computer.

3 Restart Windows to complete the installation process.
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Installing and Accessing a Shared
Copy of Message Manager

For this method of installation, the system administrator installs a single, shared
executable copy of the software on a LAN server, customizes certain files, then installs (or
notifies users to install) Message Manager to individual PCs. When users install Message
Manager to individual PCs, a minimal set of files are loaded, including msg_mgr.ini,
Personal Folders, and the Message Manager print driver if the fax package is installed.

When a user double clicks the Message Manager icon, the application is loaded from the
server to the client computer’s RAM. The user can leave Message Manager running
throughout the day without affecting other users.

1 Run setup.exe.

2 Complete the steps listed in the following table to install Message Manager Release 4.5
on the LAN server.

Screen Name Notes

Welcome
License File
Tell Me About… Included on your Message Manager CD are the

following information tools:
■ Install description
■ User Overview/Tutorial
■ Documentation

Select Installation Type Select Shared Installation. Installation choices are
described in Select Installation Type on page 6.

Important! message You should close any open software applications. For
Windows NT, you must have administrative privileges
or be logged in as Administrator to successfully install
the fax package.

Select Destination Directory Designate or create the directory on your LAN server
that will contain the Message Manager software. If you
want to load the program in a directory other than the
default, browse to the directory of your choice. If you
want to create a new directory, type the path for the
new directory in the Select Destination Directory
dialog box.

Backup Replaced Files Backed up files are saved in the Backup directory.
Personal Folders, Workbench, and Address Book files
are not automatically backed up; see Upgrade
Considerations on page 7.

Select Components For a complete installation, select Message Manager
and FAX. To add fax to a previous installation, just
select FAX.

Enter FAX Information For Shared Installations, you should leave these fields
blank. The information determines which AUDIX
mailbox opens when the user creates a fax. You can
select Options/Preferences in Message Manager to add
or update this information at a later time.
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Screen Name Notes

Ready to Install,
Installation Status Indicator

When you click Next on the Ready to Install screen,
you’ll see the Status Indicator and a listing of the
installed files.

hints.txt The hints.txt screen contains a description of each
program group icon.

Installation Complete,
Restart dialog box

The newly installed Message Manager will take effect
when you restart the computer.

3 Customize any of the following text files to suit the needs of your users:

■ custom.txt is the file that Message Manager users see when they select About Your
System... from the Message Manager Help menu. See Updating Your Site-Specific
Information on page 19 for more information.

■ hints.txt contains a description of each program group icon.

4 Install (or instruct your users to install) the necessary user files and print driver to
each individual PC by navigating over the LAN to the shared directory (created
during the LAN server install above) and running the SH_Setup.exe program. The
following table includes a description of the SH_Setup.exe install process.

Screen Name Notes

Welcome
License File
Important! message You should close any open software applications. For

Windows NT, you must have administrative privileges
or be logged in as Administrator to successfully install
the fax package.

Select Destination Directory A minimal set of files must be loaded on the client PC.
If you want to load the program in a directory other
than the default, browse to the directory of your
choice. If you want to create a new directory, type the
path for the new directory in the Select Destination
Directory dialog box.

Backup Replaced Files,
Select Backup Directory

If you want to back up the replaced system files, you
can accept the default directory or browse to the
directory of your choice. If you want to create a new
directory, type the path of the new directory in the
Select Destination Directory dialog box Personal
Folders, Workbench, and Address Book files are not
automatically backed up; see Upgrade Considerations on
page 7.

Select Components For a complete installation, select Message Manager
and FAX. To add fax to a previous installation, just
select FAX.

Enter FAX Information If you selected FAX on the Select Components screen,
you may enter the Server ID and Extension. The
information determines which AUDIX mailbox opens
when the user creates a fax. You can select
Options/Preferences in Message Manager to add or
update this information at a later time.
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Screen Name Notes

Ready to Install,
Installation Status Indicator

When you click Next on the Ready to Install screen,
you’ll see the Status Indicator and a listing of the
installed files.

hints.txt The hints.txt screen contains a description of each
program group icon.

5 Restart Windows to complete the installation process.

Installing Message Manager from a
LAN Server

For this method of installation, the system administrator copies and decompresses the
software from the CD to a LAN server, customizes certain files, then installs (or notifies
users to install) Message Manager Release 4.5 to individual PCs.

1 Run setup.exe.

2 Complete the steps listed in the following table to copy and decompress the
installation files.

Screen Name Notes

Welcome
License File
Tell Me About… Included on your Message Manager CD are the

following information tools:
■ Install description
■ User Overview/Tutorial
■ Documentation

Select Installation Type Select Copy for LAN Installation. Installation choices
are described in Select Installation Type on page 6.

Select Destination Directory Browse to or type the path for the directory in the
Select Destination Directory dialog box.

Ready to Install,
Installation Status Indicator

When you click Next on the Ready to Install screen,
you’ll see the Status Indicator and a listing of the
installed files.

hints.txt The hints.txt screen contains a description of each
program group icon.

3 Customize any of the following text files to suit the needs of your users:

■ custom.txt is the file that Message Manager users see when they select About Your
System... from the Message Manager Help menu. See Updating Your Site-Specific
Information on page 19 for more information.

■ docs.txt describes the electronic user documents and is viewable during the install
process.

■ hints.txt contains a description of each program group icon.

■ install.txt describes the install choices and is viewable during the install process.
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■ readme.txt contains late-breaking information about Message Manager Release 4.5
and is viewable at the end of the Single User Install process.

■ tutorial.txt describes the computer-based Overview tutorial and is viewable during
the install process.

4 Install (or instruct your users to install) the application to each individual PC by
navigating over the LAN to the shared directory and performing the Single User
Installation Process described on page 11.

Using the Automated Installation

For this method of installation, the system administrator updates the silent.txt (template)
file and installs the software over the LAN to users’ computers.

1 Copy the silent.txt text from the Message Manager Release 4.5 CD to your computer.
The file contains the following text:

rem This is the Prototype Silent Install Settings File

rem This file is used to create a Silent Installation of
rem Message Manager version 4.5

rem To use this settings file, invoke the installation
rem as follows:
rem
rem <path>\Setup.EXE /M=<path2>\Silent.TXT
rem
rem Where <path> is the location of the Setup.EXE installation
rem executable
rem and <path2> is the location of the Silent.TXT file being
rem used

rem Following are the Variables and values required for
rem installation.  Spelling and Capitalization are
rem CRITICAL!

rem Following line is required - do not change
SILENT=1

rem Following line is required - do not change
INSTALLTYPE=A

rem Following line is required - do not change
LANGUAGES=A

rem Following is for "What to Install"
rem
rem use A for Basic, B for FAX, AB for both
COMPONENTS=AB
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rem Following is used only for FAX install
rem
rem Provide the values for the FAX Server and Extension
rem Spelling is critical
rem
rem if left blank, install will use the previous values
rem from the msg_mgr.INI file (if present)
FAXSERVER=
FAXEXTENSION=

rem Following is for Installation Location
rem
rem Directory location for Installation
rem
rem Example - MAINDIR=C:\MSG_MGR
rem Example - MAINDIR=C:\Program Files\Lucent\Message Manager
MAINDIR=C:\Program Files\Lucent\Message Manager

rem Following is for Backup of replaced files during
rem installation
rem
rem Use A for True, B for False
DOBACKUP=A
rem Following is for backup directory
rem If backup is not selected, file name is not used
BACKUP=C:\Program Files\Lucent\Message Manager\backup

rem Following is the Name of the Program Manager Group
rem for Message Manager installation.
rem Spelling is critical
GROUP=Message Manager

rem Following is the re-boot flag
rem Windows must be re-booted before using Message Manager
rem Setting this flag will cause the install to query the
rem user about the reboot
rem Clearing this flag will not reboot, and will not ask
rem the user
rem Use S for System Reboot (recommended), W for Windows
rem reboot, and nothing for no reboot.
RESTART=S

rem End of silent install parameters

2 Customize your copy of silent.txt to specify the following:

■ COMPONENTS

■ FAXSERVER

■ FAXEXTENSION

■ MAINDIR

■ DOBACKUP
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3 Follow the instructions in silent.txt to invoke the automatic installation process.
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Updating Your Site-Specific
Information

Message Manager Release 4 and later allows users or administrators to update a custom
file with site-specific information such as the AUDIX server ID, prefixes, text-addressing
format, feature-access codes, and help numbers. Users access the custom file by selecting
About Your System from the Help menu on the Message Manager main screen.

To update the default custom file or supply your own quick-reference file:

1 Access the directory where you installed Message Manager Release 4.5.

2 Locate the default custom.txt file template automatically provided with Message
Manager. To update this file:

■ Open the custom.txt file using any ASCII text editor.

■ Follow the instructions in the template and save the file.

3 To install your own custom file of a different type (such as .doc or .hlp):

■ Move or rename the default custom.txt file template.

■ Put your custom file in the same directory as the executable Message Manager
msg_mgr.exe file. Your file must be named custom.

 If you use a file type other than .txt, you must have a computer application
associated with that extension, or the custom file will not run.

Updating the custom file varies according to your installation setup:

■ Users who share a copy of Message Manager on a LAN server all access the same
custom file, either the default template or the system administrator’s version. If the
administrator later updates the custom file, all users automatically access the new
version the next time they run Message Manager.

■ Users who install their own copy of Message Manager on a PC from a LAN server
initially get the custom file (either the default or the administrator’s version) from the
server. If this file is later updated, users must manually copy it from the server or
reinstall Message Manager.

■ Users who install Message Manager by CD must update their custom files
independently. The administrator may provide a modified custom file for users to copy
into their application directory after installation (distributed on diskette, as an attached
file, or through a LAN server). If you do this, include directions for users to rename or
remove the old or default custom.txt file.
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TROUBLESHOOTING

Introduction

While using Message Manager, you may encounter error messages or experience
technical difficulties. This section guides you through the most common of these
situations. Possible problems and suggested solutions are provided in the following
tables:

■ Common Problems

■ Login and Display

■ Audio Connections

■ Server Issues

■ Fax Problems and Print Driver Errors

Some solutions require multiple steps. Each set of steps is referenced in the applicable
table and provided directly after the table that references it.

Common Problems

Common problems and suggested solutions

Potential Problem Suggested Solution

File properties are incorrect If you change any shortcut or start menu Properties for
Message Manager, make sure the Target field
continues to call for the Message Manager executable
(.EXE) file or it will not run.

Mailbox is full If your AUDIX mailbox starts to fill up, move messages
to your personal folders. You should also delete any
unneeded messages, greetings, and outgoing message
notifications, because these all contribute to the
percentage of mailbox space used.

4
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Potential Problem Suggested Solution

Delivery Failed message Occasionally, you may receive a new message from the
AUDIX system informing you that a message failed to
be delivered. Access your Outgoing folder, select the
message that failed, then access the Message Delivery
Report. The report shows the reason the message could
not be delivered. Correct the problem if possible and
send the message again.

See Server Issues on page 27.
Message Manager locks up If Message Manager fails to respond, try each of the

following, in the order listed:
■ Press CTL-ALT and Delete. Select Message

Manager from the task list, and click End Task.
■ Exit and restart Message Manager.
■ Reboot your PC.
■ Check to see if your other Windows applications

work, or call your LAN administrator.
No default printer If you do not have a Windows default printer assigned,

exit Message Manager before you choose a default
printer in Windows. If you do not exit, Message
Manager errors may occur.

No new message notification If the Message Manager icon never raises its flag when
you have messages in the New folder, either your
AUDIX system administrator did not set up the
AUDIX server to check automatically for new
messages, or you are working offline.

Your phone doesn’t ring If you are expecting Message Manager to call and your
phone doesn’t ring, select the Hang Up button on the
lower left of the main screen because someone else
may be listening to your message. Next, check your
audio connection. Make sure the telephone number
matches the phone you are trying to use. Finally, make
sure the soundcard is not selected.

See Audio Connections on page 25.
Too many outgoing messages Message Manager can retrieve only 999 message

headers at a time. However, because messages can
generate multiple headers (a message addressed to 50
people generates 50 message headers), you might have
more outgoing message notifications than this. If so,
Message Manager alerts you that the Outgoing folder
information shown on the main screen is incomplete.

See Too Many Outgoing Message Notifications on page 23.
Messages print in the wrong
font or to the wrong printer

When you click the Quick Print button on the main
screen toolbar, the message components print to the
Message Manager default printer in the default font.
To change the default printer or font, select
Options/Preferences/Print and click Setup (to change
the printer) or Fonts (to select a different font).
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Potential Problem Suggested Solution

Some characters in printout
are missing or garbled

The font you selected may not be able to print on your
printer. Select Options/Preferences/Print and click
Fonts to choose a different default font.

Quick Print doesn’t print what
I expect it to

When you click the Quick Print button on the main
screen toolbar, Message Manager prints the message
components that you’ve designated as preferences.
Select Options/Preferences/Print and click the
components that will print when you use the Quick
Print button.

Can’t copy Personal Address
Book information.

You can export the information from your Personal
Address Book to use in other applications.

See Export Your Personal Address Book on page 24.

Too Many Outgoing Message Notifications

If you have more than 999 outgoing message notifications:

1 Message Manager retrieves the first 999 outgoing message notifications in the order in
which they appear on the AUDIX server.

2 To delete some headers and make more space in your Outgoing folder, use one of
these methods:

■ On the main screen, select one or more entries in the message list, then press the
Delete key, use the Move menu, or drag them to the Wastebasket folder. This
deletes the message (if it was not delivered to all recipients) and all message
notifications for it.

■ On the message delivery report screen, delete some or all of the message status
notifications for a particular message. For example, you might delete all Accessed or
Delivered notifications, but leave the Scheduled entries.

 Caution:  Messages or headers are deleted from the Outgoing folder immediately and
cannot be recovered.

3 To update your Outgoing folder information, select the Outgoing folder again or
choose the Folder/Refresh menu option.

4 Message Manager retrieves another 999 message headers (or all remaining entries if
the total is less than 999). Repeat Step 2 if you receive another warning about too many
message headers.
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Export Your Personal Address Book
Information

You can export a Personal Address Book database to an ASCII text (.TXT) file to use it in
another application, import it to another Personal Address Book, or quickly print all your
Personal Address Book entries.

1 From the Personal Address Book screen, select the File/Export menu option. The
Export Database as a Text File screen appears.

2 Specify the following:

■ The name for your new text file. The default is EXPORT.TXT.

■ ASCII text (.TXT)

■ The directory and drive location

3 When finished:

■ Select OK to export your Personal Address Book entries to this text file. A new text
file containing entries in Personal Address Book’s format is created.

■ Select Cancel to return to the Personal Address Book screen without creating the
file.

Login and Display

Login and display problems and suggested solutions

Potential Problem Suggested Solution

Can’t log in If you get error message, “Not a valid login”, you may
be trying to login with an incorrect server name,
mailbox extension, or password.

If you get error message, “Message Manager cannot
communicate with the server”, you probably have a
problem with the network or the TCP/IP drivers
installed on your PC.

See your LAN administrator for help.
Can't log in to your mailbox You cannot log in to your AUDIX mailbox through the

telephone interface while Message Manager is logged
in to the AUDIX server. Message Manager times out in
a few minutes. To access your mailbox immediately,
minimize, lock, or exit Message Manager.

Can't relogin If a copy of Message Manager is already running when
you try to log in to a different AUDIX mailbox,
Message Manager allows you to drop an existing PC
connection in favor of your new login request.



Audio Connections

Issue 1  May 1998 25

Potential Problem Suggested Solution

Message Manager already
running

If a copy of Message Manager is already running, you
cannot log in to the same mailbox a second time. Check
the system tray (Windows ’95 and NT 4.0 systems) or
the Task Manager (all systems) to access the open copy
of Message Manager.

Audio Connections

Audio connection problems and suggested solutions

Potential Problem Suggested Solution

Phone doesn’t ring or warning
box says “Audio connection
not established.”

See Setting Up an Audio Connection on page 25.

Messages won’t play on PC
speakers.

See Using a Soundcard to Play and Record Messages on
page 26.

Setting Up an Audio Connection

1 When you select a function that requires an audio connection, Message Manager
checks for free voice ports on the AUDIX server.

■ If no ports are available, you'll see an error message. Try again in a few minutes.

The number of audio connections is limited by the number of voice ports on your
AUDIX server. If you find yourself frequently blocked from getting an audio
connection, contact your system administrator about increasing the number of voice
ports.

■ If a soundcard is active and you wish to use an audio connection (for example, if
you have speakers but no microphone), deactivate the soundcard either through the
audio palette or the main screen Options/Use Soundcard option.

2 Message Manager dials your audio connection number. The Hang Up button in the
lower-left corner of the main screen becomes active, and your phone rings.

 Caution:  If the audio connection button is active but your phone doesn't ring, you
may be using the wrong audio connection number, or your phone is set to forward
calls directly to AUDIX or another line. To prevent the AUDIX system from playing
your message or greeting to whomever picks up the phone at the number it dialed:

■ Disconnect the audio session by selecting the Hang Up button on the main screen.
Hanging up your phone is not sufficient.

■ Check your audio connection by selecting the Options/Preferences/Audio tab.

■ Make sure that your phone is not on “Send All Calls” or forwarded to another line.

3 When your phone rings, pick up the telephone receiver, or use your speakerphone or
headset. Message Manager announces itself, then does one of the following:
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■ Begins playing the recorded message, name, or greeting

■ Beeps for you to record a message, name, or greeting

■ Instructs you to wait while it transfers the call to the requested subscriber

4 Once an audio connection is active, you can do other audio activities without a
connection delay. If you are finished with your audio connection, select the Hang Up
button to free the port for other subscribers.

5 If you do not use your audio connection for a while, it times out so other users can use
the voice port. Any new audio activities would then begin at Step 1.

 Note:  The audio connection is also dropped if you minimize or lock Message
Manager.

Using a Soundcard to Play and Record
Messages

You can record and play messages, names, and greetings through your computer using a
Windows-compatible soundcard instead of an audio connection over the telephone. A
soundcard (along with speakers and a microphone) allows you to play or record
messages offline, or to access the AUDIX server remotely using a single telephone line.
Please note that the recording quality is highly dependent upon the quality of your
microphone and soundcard. In most cases, the telephone headset or handset will provide
the best recording quality.

Caution:  The AUDIX server feature that allows messages to be transferred over the LAN
must be active for the soundcard to work. If the system administrator does not allow the
AUDIX server to transfer messages over the LAN, you cannot play or record new
messages or greetings using a soundcard. However, you can play messages stored in the
Workbench or a Personal folder using a soundcard.

1 On the main screen Options menu, select Preferences and click the Audio tab.

2 To activate the soundcard, click the Use Soundcard radio button.

3 If the Use Soundcard item is checked, the Play Immediately check box appears.

■ A checkmark next to this item means Message Manager begins to play the message
while still receiving it. Select this option if you have a fast LAN connection.

■ No checkmark next to this item means Message Manager receives the entire
message before playing it. Use this option if the network is slow or the message
sounds choppy when you play it back.

4 To deactivate the soundcard, click the Use Telephone radio button. Messages and
greetings play through your telephone.

5 Click OK to save the Preference settings and close the Preferences dialog box.



Server Issues and Delivery Errors

Issue 1  May 1998 27

 When the soundcard is selected, the soundcard indicator replaces the audio
connection indicator at the lower left of the main screen. Speakers and microphone (or
a computer headset) are required for the soundcard to:

■ Play messages or greetings (through the attached speakers or headset). When using
a soundcard, the audio palette controls (except for Stop or F4) are not available until
the first playback of each message completes.

■ Record messages or greetings (through the attached microphone or headset).

Server Issues and Delivery Errors

Delivery error messages and suggested solutions

Delivery Error Messages Possible Cause and Suggested Solution

Mailbox full
(This error may also appear
for Scheduled messages that
the AUDIX server is still
trying to deliver.)

Intended recipients must make room for new messages
by deleting some messages or greetings from their
mailboxes.

Could not transmit
(This error may also appear
for Scheduled messages that
the AUDIX server is still
trying to deliver.)

The AUDIX server could not find this recipient in the
system or network. Either the person is not a
subscriber or this number is not administered.

This error can also occur if you are trying to send a fax
but the recipient’s number is not transmitting the
necessary fax tone, or the AUDIX server cannot dial the
number through the PBX.

Recipient not found The AUDIX server could not find this recipient in the
system or network. Either the person is not a
subscriber or this number is not administered.

Permission denied The remote system cannot accept this type of message
(such as private AMIS or priority messages).

Not fax enabled
     (prior to Release 4)

The intended recipient's mailbox or AUDIX server is
not set up for fax messaging.

Not enabled for this media
     (Release 4 only)

The intended recipient's mailbox or AUDIX server
cannot accept this type of message (fax, text, or
attached file).

AUDIX Release 4 servers deliver as much of a message
to a remote server as they can (for example, only the
voice part if the recipient's server supports only voice).
Earlier servers try to deliver the complete message; if
they can't, message delivery fails.

Can't send private message You cannot send private messages to this remote
system.

Sending restrictions You cannot send messages to this recipient due to your
system's sending restrictions.
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Delivery Error Messages Possible Cause and Suggested Solution

Wrong AMIS number This appears to be an AMIS number because it contains
a # sign, but the server could not find an AMIS
recipient with this number. Check the address and re-
send the message, or call your system administrator.

Too many transmission
attempts

The AUDIX server attempts to deliver Message
Delivery or fax messages 6 times and AMIS messages 3
times. Check the address, then send the message again.

Message returned, no reason The AUDIX server returned this AMIS message to
your mailbox, but did not specify a reason. Check the
address, then send the message again.

AMIS message > 8 minutes AMIS messages cannot exceed 8 minutes. Edit your
message so it is less than 8 minutes long.

AUDIX delivery failed The AUDIX server failed to deliver this message but
did not specify a reason. Check the address, then send
the message again.

AMIS message not delivered. AMIS messages marked Private are not delivered, so
do not use this option for AMIS messages. AMIS
messages marked Priority are delivered, but without
special priority status.

Fax Problems and Print Driver Errors

Fax printing problems and suggested solutions

Potential Problem Suggested Solution

Fax pauses until print is done If you print a fax to a local or network printer through
Message Manager and the print status remains at 100%
until the print job is done, Message Manager is waiting
for the printer to finish. To avoid this, set up the system
to send jobs to the Print Manager as follows:

■ Windows 95: Access the Printers window, then
select the Printers/Properties menu option. On the
Details tab, select Spool Settings, then select "Spool
print jobs".

■ Windows NT: The Print Manager is always used.
Some characters or fonts are
missing or garbled

The font you selected may be a printer font not
supported by the Message Manager print driver. In the
application that you used to create the fax, select the
text and change the font to a True Type font.

HP LaserJet Due to problems with the HP LaserJet 4/4M print
driver, faxes do not print correctly on this type of
printer. Either:

■ Use the HP LaserJet III print driver  or
■ Install the fix for the HP LaserJet 4/4M print driver

by downloading the Microsoft HPPCL5E.DRV
Version 3.1.D1.08 file from CompuServe or the
Hewlett-Packard FTP site (ftp-boi.external.hp.com).
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Potential Problem Suggested Solution

PostScript PostScript printers have the following problems.
Installing the latest print driver often helps. Contact
your PostScript printer vendor.

■ Printing is slow and creates large files on your disk.
Depending on the size of the fax and amount of text
or graphics in it, PostScript files may range from
10K to several hundred Kbytes per page.

■ Currently only level 1 PostScript printers work with
Message Manager. Level 2 print drivers fail.

WordPerfect Do not select more than 1 or 2 copies when you create
faxes in WordPerfect. If you select multiple copies:

■ Message Manager creates each page of the fax as
many times as you have copies. For example, if you
select 5 copies, it will "write" each page of the fax 5
times.

■ WordPerfect then launches a separate instance of
Message Manager for each copy requested. Because
this is beyond the capacity of most PCs, each
instance of Message Manager fails and no faxes are
sent.

Excel 5.0 and PowerPoint 5.0
on Windows NT

Users may see an error message when they try to create
a fax. To fix this problem:

■ Before you generate the fax, go to the File menu
and select Page Setup.

■ Select Options. When the Document Properties
screen appears, select Options again.

■ On the Advanced Document Properties screen
under Color Options, change the mode to
monochrome.

Fax print driver error messages and suggested solutions

Error Message Suggested Solution

Message Manager is currently
busy

Your copy of Message Manager is already running, but
you left it while in some other activity or with the Fax
Viewer active. Return to Message Manager, close any
active screens except for the main screen, then try to
create your fax again.

Message is larger than
allowed

When you create a fax, your mailbox must be large
enough to hold the initial copy of the fax in your
Outgoing folder. If you are creating a broadcast fax,
you need a mailbox large enough to hold a copy of the
fax and cover page for each recipient.

AUDIX server is not fax-
enabled

This AUDIX server does not allow you to create fax
messages. Choose a fax-enabled AUDIX server or
contact your system administrator.
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Error Message Suggested Solution

Subscriber is not fax-enabled Your mailbox on the AUDIX server does not currently
support fax messaging. On an AUDIX Release 4 server
you can receive or view faxes, but you must be fax-
enabled to create fax messages. In earlier releases of the
AUDIX server, you must be fax-enabled to receive,
create, or view fax messages.

Message Manager is not fax-
enabled

Your copy of Message Manager does not currently
allow you to create fax messages. Reinstall Message
Manager, or ask your LAN or system administrator for
help.

Attaching a Stored Fax to a Message

1 On the create message, select the Fax button in the New Message area (or the New
Message/Select a Fax Document menu option)

■ If a fax is already attached, it appears in the Fax Viewer.

 To use a different fax, select the File/Select a Fax menu option. A list of faxes
stored in your Workbench and any selected Personal folders appears. Go to Step
2.

 To use the attached fax, select OK. The viewer closes and you return to the
Create Message screen.

 To not attach this fax, select Cancel. The viewer closes and you return to the
Create Message screen.

■ If no fax is attached, a list of faxes stored in your Workbench and any selected
Personal folders appears. Go to Step 2.

2 Scroll through the list or sort the columns to locate the fax you want to attach. The
folder name, subject, time/date, and page count can help you locate the correct fax.

3 When you have located the desired fax, do one of the following:

■ Choose Select (or double-click, or press Enter) to attach this fax component to your
new message. The viewer closes and you return to the Create Message screen.

■ Choose View to display this fax in the Fax Viewer. Go to Step 4.

■ Choose Close to not select a fax. If no fax is currently displayed, the viewer closes
and you return to the Create Message screen.
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4 If you selected a fax, it now appears in the viewer. You may now:

■ Select OK to attach this fax to your message and return to the Create Message
screen.

■ Select Cancel to not attach this fax. The viewer closes and you return to the Create
Message screen.

Printing a Fax to a Fax Machine

When you receive a fax, you can choose to print it to a printer or a fax machine. Note that
on an AUDIX Release 4 server, the system administrator may prevent users from printing
faxes to either a LAN printer or a fax machine.

1 Select the print to fax machine option as follows:

■ On the main screen, select the desired message from the message list, then select the
File/Print/Fax to Fax Machine menu option.

■ In the Fax Viewer, display a fax, then select the File/Print Fax to Fax Machine or
Entire Message to Fax Machine menu option.

2 The Enter Fax Machine Number screen appears. Enter or change the fax machine
number as follows:

■ To use the default fax machine number shown in this field, go to Step 3.

■ To use a different number, type the fax prefix (if needed) followed by the fax
machine’s complete telephone or extension number.

3 When the desired fax machine number is displayed, select OK to transmit the
message.

Note:  If your mailbox is nearly full, Message Manager may be unable to transmit a
message to the server. Make sure you have enough space in your mailbox to hold an extra
copy of your message before you try to print it to a fax machine.

Printing a Fax on a Printer

When you receive a fax, you can choose to print it to a printer or a fax machine. Note that
on an AUDIX Release 4 server, the system administrator may prevent users from printing
faxes to either a LAN printer or a fax machine.

1 To print a fax on a local or network (LAN) printer, click the Print button in the fax
viewer (or select File/Print Fax to Printer).

2 To print a fax without viewing it first, select the message that contains the fax you
wish to print and click the Quick Print button in the tool bar. To control which part of
a message prints (text, fax, or message header), select Options/Preferences and click
the Print tab.
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Message Manager can print to some printers faster than others. For example:

■ Printing to a dot-matrix printer is always slow.

■ Buffered printers work faster than nonbuffered printers.

■ Printing to a PostScript printer is slow and creates large files on your disk.
Depending on the size and composition of the fax, PostScript files can range from
10K to several hundred Kbytes per page.

Exporting a Fax

You can save any fax highlighted on the main screen or displayed in your fax viewer as a
bitmap (.BMP) or TIFF (.TIF) file on your PC or another LAN storage device. Once you
export a fax file, you cannot view the resulting bitmap or TIFF in Message Manager;
however, the fax will remain in your mailbox or personal folder until you delete it.

1 From the Fax Viewer or the main screen, select the File/Export Fax to PC menu
option. The Export Fax screen appears.

2 Specify the desired file name.

■ For TIFF files, all faxes are stored in one file.

■ For bitmapped files, specify a file name no longer than 5 characters. Message Manager
stores each page of a multiple-page bitmap as a separate file, and adds a 001, 002,
etc. to each file name after the first to keep the pages in order (for example,
xxxxx.BMP, xxxxx001.BMP, and so on).

3 Specify whether you want the fax saved as a bitmap(.BMP) or TIFF(.TIF) file.

4 Specify the directory and drive where you want the fax file saved. You may save a fax
on a different network device if your local network allows it.

 Note:  Bitmapped files can range from 40K to several hundred Kbytes in size. TIFF
files can range from 1K to several hundred Kbytes in size. You can use your own
Optical Character Recognition (OCR) software on an exported fax to convert it into a
text file.

5 Select OK to export the fax to this file. When the export completes, you return to the
previous screen.
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